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Section 1 HydroCAT-EP quick start guide

Refer to the user manual for details about each of the steps below. Each step has a link
to the related section of the user manual.

1. Install the manufacturer-supplied software on a PC. Note that the software is also
available on the manufacturer's website if the CD that comes with the sensor is
unavailable. (Install and start software on page 16)

2. Remove the end flange, then install the manufacturer-supplied batteries. Replace the
end flange. (Install batteries on page 11).

3. Remove the yellow protective label on the anti-fouling device. (Install anti-fouling
devices on page 13).

• Keep the label and the screw to attach again after to protect the intake and
exhaust ports when the sensor is not deployed.

4. Install the pH sensor. (Prepare pH sensor for deployment on page 13).

a. Loosen the screw in the copper tube to remove the dummy connector.
b. Remove the pH sensor from the white cap that keeps it wet.
c. Install the pH sensor and tighten the screw in the copper tube.

5. Prepare the pump for operation. (Set up pump operation on page 18).

• Use the manufacturer-supplied plumbing kit to fill the flow path with water.
6. Verify that the sensor operates and collects data. (Verify sensor collects data

on page 19).

a. Connect the sensor to a PC and start the software.
b. Push Settings in the dashboard of the software and select the applicable settings

in each of the tabs.
c. Push Start to collect data.

7. Verify that the sensor transmits data. (Transmit data on page 20)

• Push Transmit Data in the dashboard and select either "All Data" or "Scan
Number Range" to transmit the data collected by the sensor to the PC.

8. If necessary, verify the performance of the sensor (Verify sensor performance
on page 21):

a. Do a temperature check.
b. Do a conductivity check.
c. Do a check of the pH calibration.
d. Do a check of the optics.

9. Use the "deployment wizard" in the software to set up the sensor for a specific
deployment. (Deployment wizard on page 29).

• Controlled: (includes SDI-12 operation): On command, operate the pump, collect
one data sample, send data to PC.

• Autonomous: Sensor turns on, the pump operates, data is collected then saved in
the sensor, the sensor goes into a low power mode.

10. If necessary, attach the sensor to the frame it will be deployed on.
11. Make sure to do maintenance on the sensor at regular intervals for best sensor

performance. (Maintenance on page 33).
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Section 2 Specifications

2.1 Mechanical

Rated depth 350 m

Weight in air, water 4 kg, 1.5 kg

Length 72.1 cm

Material Plastic

2.1.1 Dimensions

HydroCAT-EP with SBE 63 HydroCAT-EP without SBE 63 HydroCAT-EP without HCO

2.1.2 Standard bulkhead connector
Contact Function MCBH-6-MP connector

1 Ground

2 RS232 RX

3 RS232 TX

4 SDI-12

5 Reserved

6 Voltage in
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2.2 Electrical

Input 9–24 VDC

Current draw, operation 140 mA

Current draw, low power 30 µA

Current draw,
communication

54 mA

Current draw, standby 46 mA

Linearity 99%

2.3 Communication

Data storage 16 Mb ~215000 samples

Communication interface RS232 or SDI-12 

RS232 output rate 600–115200 baud; 19200 default

SDI-12 output rate 1200 baud

2.4 Analytical

Parameter Range Initial Accuracy Stability Resolution

Conductivity 0–70 mS/cm ±0.003 mS/cm 0.003 mS/cm/mo 0.0001 mS/cm

Temperature -5–45 °C ±0.002 °C (-5–35 °C)
±0.01 °C (35–45 °C)

0.0002 °C/mo 0.0001 °C

Pressure 20, 100, 350 m ±0.1% full scale range 0.05% full scale range/yr 0.002% full scale range

Parameter Range Initial Accuracy Stability Resolution

Dissolved Oxygen 200% surface
saturation

±0.2 mg/L or ±2%,
whichever is greater

<0.03 ml/L/100,000 samples
@20 °C

0.005 ml/L

pH 0–14 ±0.1 0.1/90 days 0.01

2.5 Optical
Parameter Range, Sensitivity Wavelength Initial Accuracy Resolution Linearity

Chlorophyll 0–400,
0.016 µg/L/count

470/695 nm ±3% signal
equivalent of
uranine

0.007–0.37 mg/L based on
range

99%

Turbidity 0–3000, 0.01 NTU 700 nm ±1% 0.006 (0–85 NTU)
0.033 (86–550 NTU)
0.17 (551–3000 NTU)

Specifications
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Section 3 Overview

The HydroCAT-EP measures conductivity (C), temperature (T) and pH with optional
capabilities to measure pressure (D), optical dissolved oxygen (DO), chlorophyll and
turbidity. The typical HydroCAT-EP includes all of the above. The sensor is designed for
moored and other long-term, fixed-site deployments. It has an integrated pump that
operates each time the sensor collects a sample. Each sample takes 38 seconds plus the
user-specified pump operation time. The integrated pump has advantages over sensors
without pumps—

• The pump flushes the sampled water and quickly moves a new sample into the flow
path so that conductivity and oxygen measurements are more accurate.

• Water does not flow freely through the flow path so it stays saturated with the anti-
fouling chemicals.

• The optical DO sensor is integrated in the flow path for better correlation with the
CTD measurement.

The user can operate the sensor in an autonomous or controlled (polled) mode.
Autonomous operation

• RS232 
• Can use internal or external power.
• Can transmit data in real-time.
• Can transmit the last sample stored internally while in autonomous operation.
• Operation sequence:

1. The pump operates
2. The sensor measures C, T, D, and DO
3. The pump stops
4. The sensor measures fluorescence, turbidity, and pH
5. The data is stored internally
6. The sensor goes into a low power mode until the next user-defined sample time.

Controlled operation

• RS232 or SDI-12 
• RS232 can use internal or external power. SDI-12 uses external power only.
• Operation sequence:

1. The pump operates
2. The sensor measures C, T, D, and DO
3. The pump stops
4. The sensor measures fluorescence, turbidity, and pH
5. The sensor sends the data to the controller
6. The sensor goes into a low power mode until the next user-defined sample time.
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The image above shows the components and the flow path of the HydroCAT-EP with the
cell guard and anti-fouling covers removed. Note that the fluorescence and turbidity
sensor is not in the pumped flow path.

3.1 Delivered items

N O T I C E
 

Make sure to store the non-ionic surfactant and KCl solutions upright to prevent leakage. Leaks
could cause damage to the pH sensor.

P/N Description Qty

171498.1 Dummy connector and lock collar 1 ea

802220 I/O cable, 2.4 m 1 

50441 Size AA Saft lithium batteries 12 

801863 Battery holder for lithium batteries 1 

30411 Non-ionic surfactant solution to clean conductivity cell 1 

801542 Anti-fouling device, (bis)tributyltin oxide (installed) 2 

— CD with user manual, software, calibration information 1 

236098 pH dummy sensor (installed) 1 

pH sensor in white holder with KCl solution 1 

Overview
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P/N Description Qty

50647 pH maintenance kit

• thin-tipped syringe
• flathead screwdriver
• Teflon reference junction
• reference junction
• saturated KCl solution, 100 mL
• flip-top cap

1 

50704 Reference check kit

• 30385, Tygon tube, ¼" ID, 3/8" OD, 1/16" wall
• 30579, Tygon tube, 3/8" ID, ½" OD, 1/16" wall, 1.143 m
• 311422, yellow Tygon tube, 1/8" ID
• 30521, syringe, 60 cc
• 311244, female Luer thread to ¼" ID tube
• 31696, nylon reducing union, 3/8" to ¼"
• 50091, 50 ml bottle for non-ionic surfactant

1 

GXA-ZX0656 Red vinyl protective end cap, 1.75" for optical sensor 1 

SAS-542035 Optional check cap for optical sensor 1 

GXA-ZX0678 Red vinyl protective end cap, 1.875" for check cap 1 

GXA-ZX0679 Black vinyl protective end cap, 1.25" for check cap 1 

60085.1 Hardware kit

• MAA-907939, wiper blades for optical sensor (2)
• 30097, O-ring 2-111, exhaust to cell guard seal
• 30498, O-ring 2-110, anti-fouling cartridge seal
• 30857, O-ring 2-033, connector end flange
• 30858, O-ring 2-133, battery pack end cap
• 31322, O-ring 2-130, battery pack housing
• 31513, socket head cap screw, titanium, 8-32 x 5/8", sensor lift eye
• 31755, socket head cap screw, titanium, 8-32 x ¼", connector end flange to pressure housing
• 30886, socket head cap screw, stainless steel, ¼-20 x 1", plug for V2 connector flushing port
• 31811, flat head Phillips machine screw, 10-24 x 7/8" anti-fouling cover
• 30174, pan head machine screw, stainless steel, 10-24 x 9/16" anti-fouling cover
• 311663, pan head machine screw, titanium, 10-24 x 7/16", to attach cell guard
• 31755, socket head cap screw, titanium, 8-32 x ¼"
• 311242, shoulder spacer #10, nylon, for washer paired with 311663, to attach cell guard
• 30530, hex wrench, 3/16" long arm, for the plug on the white cap for KCl
• 31670, hex wrench, 3/32" long arm, for pH module
• 31671, hex wrench, 5/32" long arm, for copper anti-fouling assembly
• 31749, hex wrench, 7/64" long arm, for battery pack
• 31516, hex wrench, 9/64" long arm, for connector end flange
• 311521, removable shipping label to keep dirt out of conductivity cell

1 

Overview
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Section 4 Verify sensor operation

Make sure the sensor operates, collects, and transmits data and then set up the sensor
for deployment.

4.1 Install batteries

N O T I C E
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix
chemistries, V-Ah, or new and used batteries.

The manufacturer ships the twelve lithium batteries for the sensor separately. Do the
steps below to install or replace the batteries. See also the "how to" video on the
manufacturer's website to do this procedure.

Table 1  Recommended lithium battery brands
SAFT LS-14500 (included) 3.6 V, 2.6 Ah

Tadiran TL-4903 3.6 V, 2.4 Ah

Electrochem BCX85 series 3.9 V, 2.0 Ah

1. Make sure that the end flange and pressure housing are dry.
2. Use a 9/64" hex key to remove the two screws on the sides of the pressure housing.
3. Install these two screws into the sides of the end flange to start to loosen the end

flange.

4. If necessary, hold the bulkhead connector with a crescent wrench to make it easier to
turn the end flange.

5. Turn the end flange counter-clockwise to loosen it from the pressure housing.
6. Pull gently to disconnect the battery wires in the end flange from the battery pack.
7. Use a lint-free tissue to remove any water from the O-ring surfaces inside the

pressure housing and end flange.
8. Use a 7/64" hex key to loosen the captured screw in the battery cover plate.
9. Remove the battery pack from the pressure housing.
10. Turn the yellow cover plate counterclockwise to remove it from the battery pack body.
11. Move each of the two O-rings on the outside of the battery holder from the grooves.

It makes it easier to remove or insert batteries.
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12. Examine the O-rings and surfaces for dirt, cuts, or other damage.
Clean or replace as necessary.

13. If necessary, remove the size AA batteries in the pack.
14. Insert new batteries.

Make sure to alternate the positive (+) and the negative (-) ends on the size AA
batteries to agree with the labels on the pack as they are installed.

15. Move the O-rings back into the grooves.
16. Align the pin on the yellow battery cover with the post hole in the battery pack

assembly.

17. Align the "D"-shaped part of the battery pack with the pins on the shaft.
18. Slowly move the assembly onto the housing. Push gently to connect the battery

assembly with the circuit board in the pressure housing.
19. Use a 7/64" hex key to tighten the captured screw on the yellow battery cover onto

the shaft in the pressure housing.
20. Attach the Molex connector on the end flange to the connector in the pressure

housing.

Verify sensor operation
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21. Examine the O-rings on the end flange. They must be pristine, with no lint or
scratches or chips.

• Apply a small quantity of Parker Super O Lube® to any new O-rings.
22. Align the end flange holes with the holes in the pressure housing.
23. Carefully push the end flange into the pressure housing.

It may help to rotate the end flange so that the wires do not bend too much.
24. If necessary, use a 9/64" hex key to remove the two screws from the end flange.
25. Use a 9/64" hex key to install the two screws into the pressure housing of the sensor

again.

4.2 Install anti-fouling devices
New sensors have two anti-fouling devices and a yellow protective label installed by the
manufacturer.

C A U T I O N
 

Make sure to remove the label before the sensor is deployed or pressurized or the conductivity
cell can be damaged.

1. Remove the yellow label.

• The user can make sure the anti-fouling devices are installed: refer to section
about Remove or replace anti-fouling devices on page 33 for details.

2. Keep the label to attach again to protect the intake and exhaust ports when the
sensor is not deployed.

4.3 pH sensor

N O T I C E
 

The pH sensor must be kept wet. Fill the flow path on the HydroCAT with fresh (not de-ionized)
water between deployments, or remove the pH sensor and store it in the white KCl holder.

The pH sensor for the HydroCAT-EP ships separately in a white cap that is filled with
potassium chloride (KCl) solution to keep the glass bulb and reference electrode wet. The
user must install the pH sensor before the instrument is deployed to measure pH. Make
sure to keep water and dirt off of each of the connectors on the pH sensor and the
HydroCAT-EP.

4.3.1 Prepare pH sensor for deployment
The dummy pH sensor protects the sealing surfaces of the pH sensor and the HydroCAT-
EP when the HydroCAT-EP is in storage or in shipment. Replace the dummy with the real
pH sensor before deployment.

Verify sensor operation
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Protective dummy pH sensor pH sensor

1. Use a 3/32 inch hex wrench to carefully loosen the two captured socket head screws
that attach the dummy pH sensor to the HydroCAT-EP.

The screws will stay in the dummy pH sensor.
2. Pull the dummy pH sensor straight up and do not twist or tilt to disconnect it from the

HydroCAT-EP.
Keep the dummy pH sensor.

3. Use a lint-free swab or tissue that is moist with isopropyl alcohol to carefully clean the
connector area and sealing surfaces of the HydroCAT-EP.

4. Use compressed air to completely dry the connector area and sealing surfaces of the
HydroCAT-EP.

5. Under good lighting, examine the connector area and sealing surfaces on the
HydroCAT-EP for scratches or debris.
Scratches or debris on the sealing surface can let water into the connector on the pH
sensor during a deployment and cause corrosion.

Verify sensor operation
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6. If dirty, do steps 3 through 5 until clean.
7. Under good lighting, examine the dummy pH sensor and O-rings for debris. Use a

lint-free swab or tissue that is moist with isopropyl alcohol to clean if necessary.
8. Apply a light coat of silicone-based Parker Super O Lube® to the installed O-rings on

the dummy pH sensor. Do not use WD-40 or other petroleum-based lubricants.
9. Keep the dummy pH sensor.
10. Hold the pH sensor so that the white holder is on the bottom, and use the 3/16 inch

hex wrench to remove the plug on the side of the white holder to drain the solution.

11. Install the plug into the holder again.
12. Use a 3/32 inch hex wrench to carefully loosen the two captured head screws on the

top of the pH sensor that attach the pH sensor to the white holder.

The copper plate will not disconnect and the screws will stay in the pH sensor.
13. Pull the pH sensor from the white holder: pull straight up and do not twist or tilt the pH

sensor.
14. Make sure that the sealing surfaces of the pH sensor are clean and lubricated:

a. Use a lint-free swab or tissue that is moist with isopropyl alcohol to carefully clean
the connector area and sealing surfaces of the HydroCAT-EP.

Verify sensor operation
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b. Under good lighting, examine the connector area and sealing surfaces on the
HydroCAT-EP for scratches or debris.
Scratches or debris on the sealing surface can let water into the connector on the
pH sensor during a deployment and cause corrosion.

c. If dirty, do steps a and b until clean.
Note that the calibration of the pH sensor will change if the glass bulb is kept dry
for longer that a few minutes.

d. Apply a light coat of silicone-based Parker Super O Lube® to the installed O-rings
on the dummy pH sensor. Do not use WD-40 or other petroleum-based
lubricants.

15. Install the pH sensor: align the pins on the pH sensor connector with the sockets on
the HydroCAT-EP. Do not over-tighten.

16. Use a 3/32 inch hex wrench to carefully tighten the two captured socket head screws
in the top of the pH sensor and into the HydroCAT-EP. Do not over-tighten.

17. Put the dummy pH sensor on the white holder.
18. Use a 3/32 inch hex wrench to carefully tighten the two captured socket head screws

in the top of the dummy pH sensor on to the white holder. Do not over-tighten.
The dummy pH sensor is in storage during deployment of the HydroCAT-EP.

19. If necessary, do the pH calibration procedure. Refer to pH calibration on page 26 for
details.

4.4 Install and start software
Install the manufacturer-supplied software and make sure that the sensor is ready to test
for functionality before configuration and deployment. If the sensor is so equipped, install
the batteries if necessary. The manufacturer-supplied UCI software communicates with a
number of sensors. The sensors that are supported are listed in the Sensor menu of the
software.

1. Get the software from the manufacturer's website or the manufacturer-supplied USB
drive or CD.

2. Install the appropriate software.

a. For Windows®: Double-click on the file with ".exe" appended to the name.
b. For Mac OS X®: Double-click on the file with ".pkg" appended to the name. Make

sure that the default "Install for all users on this computer" is selected as the
destination for the installed software. If "Install for me only" or "Install on a
specific disk" is selected, the software will not connect to the sensor.

3. Push Run in the new window.
The setup wizard starts.

Verify sensor operation
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4.5 Verify sensor operation
Make sure that the sensor has new batteries installed or is connected to a power supply
(optional) or SDI-12 controller, and PC through the RS232 connector on the supplied
cable, and is on.
Most PCs no longer have RS232 "COM" ports so an RS232-to-USB converter is
necessary. Make sure that the USB driver software is installed on the PC so that there is
communication between the sensor and the PC.
Do the steps below to make sure that the sensor operates, collects, and transmits data
with the settings selected by the user before further setu and deployment.

1. Connect the test cable to the sensor, the PC, and a regulated power supply set at
12 V.

2. If necessary, start the software.
3. Push Connect in the Dashboard area or at the top of the UCI window.
4. If necessary, change the "Instrument Type" to the connected sensor.
5. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
6. If necessary, select the communication port.
7. Push Connect.

The "Connection Mode" shows "Transition" on a yellow background, and then shows
"Setup" on a green background. The software is in communication with the sensor.

8. Select the UCI menu, then Preferences.
9. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

10. Push OK.

4.5.1 Set up output format
The parameters selected in this tab change the data that is moved to the PC and the data
that shows in the Real Time Display tab. Parameters that are not selected are still
collected and stored as data by the sensor but do not show in the Real Time Display tab.

1. Push Settings in the Dashboard of the connected sensor.
2. On the Output Format tab: if necessary, change any of the Parameter Units.

Table 2  Parameter units
Temperature Celsius*, Fahrenheit

Conductivity uS/cm*, S/m, mS/cm

Pressure Decibar*, PSI

Oxygen mg/L*, ml/L

* default parameter
3. If necessary, change any of the Parameters to Output, or push Default to use the

manufacturer-set values.
Table 3  Output parameters

Temperature* Salinity

Conductivity Sound velocity

Verify sensor operation
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Table 3  Output parameters (continued)
Pressure* Specific conductivity*

Oxygen* Sample number

* default parameter
4. Push Apply to save the values in the sensor.

4.5.2 Set up data collection
Select the Data tab to set the interval at which the sensor collects data.

1. Select the Data tab to set the interval between samples.
The sensor collects data at the end of the specified interval.

2. Enter a value between 10–21600 seconds in the "Sample Interval" area.
3. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.

4.5.3 Set up pump operation
Select the Pumping tab to set the values for the operation of the pump. The software
automatically gets the Zero Conductivity Frequency and the Minimum Conductivity
Frequency values from the connected sensor and shows them in the Pumping tab. The
Minimum Conductivity Frequency value is the Zero Conductivity Frequency plus the offset
value for either salt water (500 Hz) or fresh water (1 Hz). This sum is the minimum
conductivity frequency at which the pump will operate.

1. If necessary, change the "Minimum Conductivity Frequency."

• If the sensor is set up to operate in an autonomous mode, the pump will operate
a "pre-flush" for a manufacturer-set default of 300 seconds before data is
collected. This removes air from the plumbing and primes the pump. The user
can enter a value from 300–600 seconds for the "Pre-flush Duration."

• If the sensor is set up to operate with a controller ("polled" mode), put a check in
the box next to " Scheduled Pre-flush for Polled Sampling." Make sure to set the
pre-flush cycle to complete before the sensor starts to collect data. Data
collection will cancel the pre-flush operation.

Verify sensor operation
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Select the "Start Date."
Select the "Start Time" (hours).

2. Push Apply.

4.5.4 Baud rate
The software automatically finds the baud rate for the connected sensor.

Available baud rates:

600 19200 

1200 38400 

2400 57600 

4800 115200 

9600 

1. Refer to Transmit data on page 20 for details about how the software temporarily
sets a faster baud rate to transmit data.

2. Push Apply.

4.6 Verify sensor collects data
1. If necessary, start the software.
2. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

3. Push OK.
4. If necessary, change the "Instrument Type" to the connected sensor.
5. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
6. Push Connect in the Dashboard area or at the top of the UCI window.
7. Push Settings in the Dashboard of the connected sensor.
8. On the Output Format tab: if necessary, change any of the Parameter Units.

Table 4  Parameter units
Temperature Celsius*, Fahrenheit

Conductivity uS/cm*, S/m, mS/cm

Pressure Decibar*, PSI

Oxygen mg/L*, ml/L

* default parameter
9. If necessary, change any of the Parameters to Output, or push Default to use the

manufacturer-set values.
Table 5  Output parameters

Temperature* Salinity

Conductivity Sound velocity

Pressure* Specific conductivity*

Oxygen* Sample number

* default parameter

Verify sensor operation
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10. Push Apply to store the settings in the sensor.
11. Select the Data tab to set the interval between samples.

The sensor collects data at the end of the specified interval.
12. Enter a value between 10–21600 seconds in the "Sample Interval" area.
13. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.

14. Push Apply to save the values in the sensor.

4.7 Transmit data
Use the UCI software to transmit data stored in the sensor to a PC.

1. Push Transmit Data in the Dashboard area.
The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is 115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to the
default for the connected sensor.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is copied to the PC.
• The software uploads a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

Verify sensor operation
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Section 5 Verify sensor performance

To make sure that the sensor operates at optimum precision, the user must do various
checks and updates to the sensor at regular intervals. Use the software to do these
checks.

5.1 Temperature check
Use a sensor that has the same or better specification for accuracy of the unit under test
as a reference to validate the temperature stability. The manufacturer recommends that
the user does this check in a laboratory because the temperature of the water in the
temperature check bath must be stable. Pass criteria:

• data is within 0.2 °C of the reference sensor
• three data points are within 0.01 °C.

1. Put the sensor in a temperature-stable water bath as close as possible to the sensor
that is being used as a reference.

2. Let the sensors become stable for at least one hour, or more if there is a large
difference between the water and the room temperature. Make sure that the
temperature of the reference sensor is stable to within 0.05–0.1 °C.

3. Record the temperature of the water in which the sensor is submerged.
4. Push Temperature Check in the Dashboard area.
5. Push Next to start the check.
6. Enter the water temperature in °C in the "Temperature" area.
7. Push Start.

The software takes a few minutes to collect data for the test. The results show in the
"Status" area.

8. Push Next.
9. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

check information.
10. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
11. Push Finish.

21



The Temperature Check window closes and the .pdf report shows if the "View" box
has a check in it.

5.2 Conductivity checks
The software lets the user do a check of the accuracy of the conductivity measurements
made by the HydroCAT and the HydroCAT-EP. This shows that the conductivity cell
operates within specifications. There are two conductivity checks:

1. Zero conductivity

N O T I C E
 

Do not blow canned air into the intake or exhaust ports to dry the conductivity cells. It causes
damage to the cells.

Make sure that the conductivity cell is clean and dry, then start the check.

• For the HydroCAT-EP, this value is stored in the sensor.
• For the HydroCAT, this value is on the manufacturer-supplied calibration page.

Pass criterion for sensor: 0.3 Hz of calibrated conductivity.
2. Conductivity of a user-supplied conductivity standard solution.

• Use enough solution to completely fill the flow path of the sensor.
• Do this check after the solution and the sensor are at ambient temperature.

Pass criterion for sensor: 0.02 mS/cm of standard solution.

5.2.1 Zero conductivity check
The conductivity cell must be clean and dry to do the zero conductivity check. Refer to 
Clean flow path on page 33 for details.

1. Remove the pH sensor if the flow path will be dry for more than 2 hours so that the
sensor does not dry out. Refer to Prepare pH sensor for storage or shipment
on page 36 for details.

2. Remove the anti-fouling assembly. Refer to Remove or replace anti-fouling devices
on page 33 for details

3. Push Conductivity Check in the Dashboard area.
4. Push Next to start the check.

Verify sensor performance
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5. At step 2, "Calibration Zero Conductivity Frequency Check":

• HydroCAT—enter the first value form the "INST FREQ" column on the
manufacturer-supplied calibration page.

• HydroCAT-EP—the software automatically enters this value from the sensor.
6. Push Start.

The software takes a few minutes to collect data for the test. The results show "Check
Complete" in the "Status" area when the test is complete. If the conductivity value is
within 1.0 Hz of the calibrated zero conductivity, the sensor passes.

• If the sensor fails the conductivity check, refer to Clean flow path on page 33 for
details on how to flush the flow path with Triton X-100™ solution and then rinse
with DI water. It may be necessary to flush the sensor several times.

• Make sure that the conductivity cell is clean and dry, then push Start to do the
conductivity check again.

7. Push Next.
The software shows the steps to complete the check for the user-supplied
conductivity standard.

8. Push Next.
The software is ready to do the check of the sensor with the conductivity standard
solution.

5.2.2 Conductivity standard check
The manufacturer recommends that the user verify the sensor calibration before and after
a deployment or when it has been in contaminated water.
Make sure that the sensor and the solution(s) are at the same stable temperature.
Supplies necessary to do the check:

• The manufacturer-supplied kit (P/N 50704) that has the necessary tubing and tools.
• 60 ml each of user-supplied conductivity standard solutions for calibration.
• 500 ml bottle of DI water
• Container for the sensor
• Container for waste water

Make sure that the output values of the sensor agree with a user-specified standard
solution.

1. Remove the anti-fouling assembly from the sensor if necessary. Refer to Remove or
replace anti-fouling devices on page 33 for details.

2. Flush the sensor with DI water.

a. Put the sensor in a container.
b. Attach a 10 cm length of tubing to either the intake or exhaust port of the sensor.

Verify sensor performance
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c. Attach a length of tubing to the syringe.
d. Pull approximately 30 ml of DI water into the syringe.
e. Attach the syringe and tubing to either the intake or the exhaust port of the

sensor.

f. Push the syringe plunger to fill the sensor until 3–5 cm of solution shows in each
tube.

g. Push and pull the syringe plunger until there are no bubbles in the tubing.
h. Remove the sensor from the container and drain the fluid in the sensor into a

waste container. Push the syringe plunger to help remove all of the fluid from the
sensor.

i. Remove the tubing and shake the sensor.

Verify sensor performance
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The sensor is ready for a functional test in the laboratory, or for a deployment.
3. Flush the flow path of the sensor with the solution that will be used to test the output

of the sensor (step 2 A–H).
4. Fill the flow path of the sensor with the conductivity standard solution (step 2 A–F).
5. Enter the value of the conductivity standard in step 4 of the Conductivity Check.
6. Push Start.

The software takes a few minutes to collect data for the "Standard Check" test. The
results show "Conductivity Check Passed" in the "Status" area.

• If the sensor fails the conductivity check, refer to Clean flow path on page 33 for
details.

• When the flow path of the sensor has been flushed, fill with the appropriate
solution and push Start to do the conductivity check again.

7. Drain the solution in the flow path into a waste container.
8. To do another check with a different solution value:

a. Flush the sensor with DI water.
b. Flush the sensor with the next conductivity standard solution.
c. Fill the sensor with the next conductivity standard solution.

9. Push Next.
10. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

check information.
11. Push Next.

Verify sensor performance

25



The software saves a .pdf report in the user-specified location on the PC.
12. Push Finish.

The Conductivity Check window closes and the report opens if the "View" box has a
check in it.

13. Install the pH sensor again if the sensor will be deployed within an hour or two.
14. Install the anti-fouling assembly again.

5.3 pH calibration

C A U T I O N
 

Wear latex gloves, a lab coat, and safety glasses. Wash hands after use.

Make sure that the pH values of the HydroCAT-EP agree to ±0.05 pH with the
manufacturer-supplied calibration values.
Supplies necessary to do the calibration:

• The manufacturer-supplied kit (P/N 50704) that includes the necessary tubing and
tools

• 60 ml each of colorless buffers for pH calibration
• 60 ml each of user-supplied conductivity standard solutions for conductivity standard

verification.
• 500 ml bottle of DI water
• Container for waste water
• Container for the sensor.

Make sure that the sensor and the pH calibration buffers are at a stable temperature.
If necessary, remove the anti-fouling assembly from the sensor.
The general procedure for each calibration step:

1. Flush the sensor and tubing with DI water.
2. Flush the sensor and tubing with the appropriate calibration solution.
3. Fill the sensor with the appropriate solution and operate the sensor with the software

to measure the output: from the sensor Dashboard, push pH Calibration and do the
steps for each pH standard.

Refer to Conductivity standard check on page 23 for procedure to flush and fill the sensor
flow path.

Verify sensor performance
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5.4 Optics check
Users that have the optional check cap can do the steps below to make sure that the
optical values of the HydroCAT-EP agree to within 20% of the manufacturer-supplied
calibration values of the sensor. Make sure that the temperature of the sensor is
18–26 °C or the optics check is not valid.

1. If necessary, remove the red protective cap from the optical face of the sensor so that
the optional check cap can be attached.

2. Make sure that the inside of the check cap is shiny, clean and dry and attached to the
optical face of the sensor. Refer to Maintain optical sensor on page 40 for details
about the maintenance of the optical face and the check cap.

3. To "pair" a new check cap with the optics:

a. Go to the Sensor menu, then HydroCAT-EP, Advanced, then Pair Optics Cal
Cap.

b. Enter the serial number of the new calibration cap, then push OK. The software
updates the reference values in the sensor.

c. Push OK to finish.
4. Do the steps below to do a check with a currently owned optical check cap.
5. Push Optics Check in the Dashboard area.
6. Push Next.
7. Push Start.

The software looks at the calibration values saved in the sensor. This will take
approximately 2 minutes.

8. If the sensor passes the optics check, go to step 10.
9. If the sensor fails the optics check:

• Make sure that the calibration cap is straight on the optical face and that the
index pin on the cap is in the notch on the sensor.

• Clean the optical face of the sensor and the orange glass of the cap.
• Do the optical check again.

10. Push Next.
The Create Optics Check Report window shows.

11. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

check information.
12. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
13. Push Finish.

The window closes and the report opens if the "View" box has a check in it.

Verify sensor performance
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Section 6 Deployment

6.1 Deployment wizard
1. If necessary, make sure that the sensor is connected to the software.
2. Push Deployment Wizard in the Dashboard of the connected sensor.
3. Deployment Setup step 1: Select "Autonomous Sampling," or "Polled Sampling"

(SDI-12 or RS232).
4. Push Next.
5. Deployment Setup step 2: For "Autonomous Sampling": Set the date and time to

start data collection. Then push Next.
Put a check in the box next to "Transmit Real Time" to see the data as it is collected
in a terminal program or a data controller. If the user does not put a check in the box,
the sensor still collects and saves data, but it does not show the data in real time.

6. Deployment Setup step 3: For "Polled Sampling (SDI-12)": The manufacturer-set
default address is 0. Users can change this if necessary. Use the "Bad Data Flag"
default value of 9999999, then push Next.

7. Deployment Setup step 4: If necessary, change any of the settings in the Parameter
Units area and Parameters to Output.

8. Deployment Setup step 5: Enter the minimum conductivity frequency. Refer to the
section on Conductivity checks on page 22 for details on this value.

• Fresh water deployment—add a 1 Hz offset to the zero conductivity value of the
sensor.

• Salt water deployment—add a 500 Hz offset to the zero conductivity value of the
sensor.

9. Deployment Setup step 6: Put a check in the box to set the internal clock of the
sensor to the same time as the PC.

• Put a check in the box "Clear HydroCAT/EP data" to erase the data from the
internal memory of the sensor.

• If necessary, enter a pressure offset. If the sensor is deployed at sea level, enter
0.0 in the "Pressure Offset" area. The range is from -3402823 to 3402823.

10. Deployment Setup step 7: Enter the approximate minimum temperature of the water
in which the sensor will be deployed.

• Enter the approximate depth of water in which the sensor will be deployed.
• Enter the time interval between each sample for either autonomous or logger-

controlled (polled) operation.

• Range for HydroCAT: 10–21600 seconds
• Range for HydroCAT-EP: 75–21600 seconds

The calculated battery capacity and the number of 24-hour periods that the sensor
can operate is given as a reference. Note: The software calculates "Battery
Endurance" for new batteries only. Deployment time decreases for used batteries.

11. Push Next.
12. Deployment Setup step 8 (optional): make a Deployment Report.

• Enter the "Operator Name."
• Enter any text in the "Comments" area.
• Push Browse to change the location at which the report is saved on the PC.
• Put a check in the box next to "Overwrite if Existing" to save the new report only.

13. Push Finish. The sensor disconnects from the software.

• If the sensor was set up in a logger-controlled or "polled" mode, use the controller
unit to control the collection of data.

29



• If the sensor was set up in an autonomous mode and there is a check in the
"Transmit in Real Time" box from Step 2 of the Deployment Setup, start a
terminal program to monitor data in real time.

14. When the deployment is complete, the user can connect to the software again and
push Transmit Data in the Dashboard to move the data that is saved in the sensor to
the PC.

6.2 Set up sensor
Prepare the sensor for deployment, then use the software to make sure that the sensor
has the appropriate settings for the deployment.

1. Make sure that the hardware is prepared for deployment:

• Make sure that the batteries are installed and supply sufficient power for the
deployment. The nominal installed battery capacity is 7.8 Amp-hours (2.6 Amp-
hours × 3 parallel strings of batteries). Capacity is dependent on the
environmental conditions of a deployment. The manufacturer recommends a
value of 6.0 Amp-hours as a conservative estimate of capacity. The sensor will
stop operation if the voltage goes below 7.1 VDC for five consecutive samples.

• Make sure that the pH sensor is installed. Refer to Prepare pH sensor for
deployment on page 13 for details.

• If necessary, remove the yellow protective label from the intake and exhaust
outlets.

• Make sure that the anti-fouling devices are installed and are sufficient for the
deployment. Refer to Remove or replace anti-fouling devices on page 33 for
details.

• Remove the red protective cap from the optical sensor.
2. Make sure that the bulkhead connectors on the sensor and the cable or dummy plug

are lubricated. Refer to Clean bulkhead connectors on page 43 for details.
3. Attach the cable or dummy plug to the sensor.
4. Make sure that the sensor is correctly attached to any mounting hardware.
5. If necessary, start the software and start communications with the sensor. If the

sensor is to be deployed with the connector end down, The manufacturer
recommends—

• For cabled deployments, operate the pump for 5–15 minutes to help clear any air
from the flow path.

• For non-cabled deployments deeper than approximately 30 m, let the sensor
operate for a day so that any air in the flow path dissolves and the pump primes
correctly.

• For deployments at which sediment is greater than 200 NTU, operate the sensor
connector-end down to reduce the quantity of sediment going to the intake area.

• Do not deploy the sensor in a horizontal orientation. Sediment collects in the
conductivity cell and the data will be of poor quality. If the sensor must be
deployed this way, mount it at a minimum of 10 degrees slope with the intake
above the exhaust.

6. Put the sensor in the water.

Deployment
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Section 7 Transmit data

Use the UCI software to transmit data stored in the sensor to a PC.

1. Push Transmit Data in the Dashboard area.
The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is 115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to the
default for the connected sensor.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is copied to the PC.
• The software uploads a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

7.1 Export data to .csv or MS Excel format
Data from the sensor can be saved to either a comma-separated (.csv) file or a
Microsoft® Excel file with a local or UTC time stamp. Use the software to transmit data
from the sensor and then export that data to a human-readable format.

1. From the Data menu, select Export Stored Data.
2. Push Browse to find the file to export.
3. Select the file from the list.
4. Push Open.
5. Push Next. The current output format shows (all sensors but SUNA).
6. Push Next. Select the options for the file to export:

a. Select either "Excel Workbook" or "Comma Separated Values" in Export File
Format.

b. Select the filters to apply to the data in Export Samples QAQC Filter (ECO
V2 only.)

c. Select either the "UTC" or "Local" time stamp in Format Options.
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7. Push Browse to select the directory in which the exported data will be saved.
8. Push Finish.

7.2 Show data from the sensor
1. Go to the Data menu and select the applicable sensor.
2. Push Show Data from Sensor.
3. Select the data file to look at.
4. Push Open. The data shows in the Time Series graph.

7.3 Show data from multiple sensors
The software lets the user show data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to look at.

1. Go to the Data menu, then Show Data from Sensor.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors to Show.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.

Transmit data
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Section 8 Maintenance

8.1 Remove or replace anti-fouling devices

C A U T I O N
 

AF24173 anti-fouling devices contain bis(tributyltin) oxide. Wear rubber or latex gloves and eye
protection to replace these devices on the sensor. Wash hands with soap and water when
finished.
Read the precautions on the product label.
It is a violation of US federal law to use this product in a manner that is inconsistent with its label.

Remove the anti-fouling devices as a first maintenance task to save the anti-fouling
material for deployments.

1. Use a 5/32 inch hex wrench to loosen the two captured cap screws that attach the
copper anti-fouling assembly to the plastic assembly on the pressure housing.
Carefully remove the copper anti-fouling assembly from the housing.

2. Remove the three Phillips-head screws from the copper anti-fouling assembly, and
pull the copper guard off of the plastic anti-fouling holder.

3. Remove the protective plug from the anti-fouling device cup.
4. Use a toothpick to lift each of the anti-fouling devices out of the holder. If necessary,

use needle-nose pliers to carefully break up the device

Option Procedure

To deploy
sensor

Insert new anti-fouling devices into the cup, then install the cap onto the
cup. Do not tighten too tight.
Attach the copper assembly to the sensor again.

To clean or
store sensor

Do not insert new anti-fouling devices. Install the protective plug. Make
sure to remove the plug before the next deployment or pressurization of the
sensor. Damage to the conductivity cells can be caused if the plugs are not
removed.

8.2 Clean flow path

C A U T I O N
 

Wear latex gloves, a lab coat, and safety glasses. Wash hands after use.

The manufacturer recommends that the user thoroughly clean the flow path before and
after a deployment to make sure that the sensor continues to collect accurate, high-
quality data. Correct maintenance of the flow path is critical for the multi-parameter
measurement capabilities.
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Supplies:

• 500 ml bottle of DI water
• container for waste water
• container for sensor.
• De-ionized or distilled water. If unavailable, use fresh tap water. Do not use shipboard

fresh water because it can have traces of oil in it.
• Non-ionic surfactant. The manufacturer supplies this with each sensor. It is a

secondary alcohol ethoxylate, a non-ionic detergent that is biodegradable. Make sure
that any alternative detergent that is used is scientific grade, with no colors,
perfumes, glycerins, lotions, etc.

• Bleach mixed 50:1—Household bleach is usually 4–7% (40,000–70,000 ppm) sodium
hypochlorite with stabilizers.

• Manufacturer-supplied tubing and syringe to clean the plumbing.

Procedure notes:
Use warm 30 °C (86 °F) water and 1% non-ionic surfactant to flush the flow path for one
minute.
It may be necessary to do these steps up to five times to clean the flow path.
If there is bio-fouling on the sensor it may be necessary to fill the flow path with the non-
ionic surfactant solution for approximately 12 hours to loosen debris.
Make sure to remove the anti-fouling assembly if necessary.
Concentrated surfactant or bleach can have a negative effect on the performance of the
pH sensor. To use surfactant or bleach to clean the flow path of the sensor, remove the
pH sensor and store the sensor in the white holder with KCl solution or DI water.

1. Remove the pH sensor (HydroCAT-EP only) and store it in the white plastic holder
with KCl solution or de-ionized (DI) water if non-ionic surfactant or bleach is
necessary to clean the flow path. The pH sensor can stay installed on the sensor if DI
water is used. Do not expose the pH sensor to air for longer than a few minutes.
Refer to Prepare pH sensor for storage or shipment on page 36 for details to
remove the pH sensor.

2. Put the instrument in a container with the bulkhead connector face-up.
3. If a cleaning solution is necessary, pull approximately 30 ml of DI water into the

syringe.

4. Pull approximately 30 ml of cleaning solution into the syringe.

Maintenance
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5. Push the syringe plunger to fill the sensor flow path until 3–5 cm of solution shows in
each tube.

6. Push and pull the plunger to mix the solution in the flow path. Do this 2–3 times.
7. Drain the solution from the sensor into a waste container. Push the syringe plunger to

help remove all of the solution from the sensor.

8. Remove the tubing and shake the sensor.

9. If the flow path is still not clean, do steps 11–16 with the bleach solution.
10. Flush the flow path with DI water.
11. Install the flushing port plug again.

The sensor is ready for a functional test in the laboratory or a deployment.

Maintenance
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8.3 pH sensor

N O T I C E
 

The pH sensor must be kept wet. Fill the flow path on the HydroCAT with fresh (not de-ionized)
water between deployments, or remove the pH sensor and store it in the white KCl holder.

The pH sensor for the HydroCAT-EP ships separately in a white cap that is filled with
potassium chloride (KCl) solution to keep the glass bulb and reference electrode wet. The
user must install the pH sensor before the instrument is deployed to measure pH. Make
sure to keep water and dirt off of each of the connectors on the pH sensor and the
HydroCAT-EP.

8.3.1 Prepare pH sensor for storage or shipment
Do the steps below to remove saltwater from the area near the pH connector to reduce
the risk of connector corrosion. The pH connector is not wet-pluggable. Do not assemble
when wet, especially with saltwater. Due to the location of the pH connector, there is a
risk that water will splash on it when the pH sensor is removed from the HydroCAT. If DI
water is splashed on the connector, use compressed air to blow away or evaporate any
water with little risk of corrosion.

1. Use a 3/16 inch hex wrench to remove the pH flushing port plug. Keep the plug.

2. Turn the HydroCAT-EP so that the pH module faces down to drain water from the
HydroCAT-EP and out of the pH flushing port. Shake several times to make sure that
it is completely drained of water.

3. Turn the HydroCAT so that the pH sensor is face up.
4. Fill a syringe with 60 mL of de-ionized (DI) water and connect to the manufacturer-

supplied yellow tube.

5. Put the other end of the yellow into the pH flushing port on the HydroCAT-EP.

Maintenance
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6. Push the plunger on the syringe to flush the area around the pH sensor, so that all
the saltwater is flushed out.

7. Remove the yellow tube from the pH sensor flushing port.
8. Turn the HydroCAT-EP so that the pH module faces down to drain water from the

flushing port. Shake several times to make sure that it is completely drained of water.
9. Use a 3/32 inch hex wrench to loosen the two captured screws in the dummy pH

sensor from the white holder.

Keep the dummy pH sensor.
10. Make sure that the plug on the side of the white holder is installed. If necessary,

install the plug.
11. Fill the white holder with KCl solution. Keep the white holder.
12. Remove the pH sensor from the HydroCAT-EP:

Maintenance
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a. Use a 3/32 inch hex wrench to loosen the two captured screws on the top of the
pH sensor that hold the pH sensor to the HydroCAT-EP. The screws will stay in
the pH sensor.

b. Pull the pH sensor straight off of the HydroCAT.
Do not twist or tilt the pH sensor, which could cause damage to the connector.

13. Use a lint-free tissue that is moist with isopropyl alcohol to carefully clean the pH
sensor connector and O-rings.
The connector on the pH sensor should be completely dry.

14. Under good lighting, examine the connector and sealing surfaces on the pH sensor
connector area and sealing surfaces. Scratches or debris on the sealing surface can
let water into the connector on the pH sensor during a deployment and cause
corrosion.

15. Apply a light coat of silicone-based Parker Super O Lube® to the installed O-rings on
the pH sensor.
Do not use WD-40 or other petroleum-based lubricants. They will cause damage to
the connector.

16. Put the pH sensor on the white holder filled with KCl solution.
17. Use a 3/32 inch hex wrench to carefully tighten the two captured screws on the top of

pH sensor into the white holder. Set the assembly aside.
Do not over-tighten the screws.
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18. Use a lint-free swab or tissue that is moist with isopropyl alcohol to carefully the
connector area and sealing surfaces on the HydroCAT-EP.

19. Use compressed air to completely dry the connector area and sealing surfaces of the
HydroCAT-EP.

20. Under good lighting, examine the connector area for scratches or debris. Scratches
or debris on the sealing surface can let water into the connector on the pH sensor
during a deployment and cause corrosion.

21. If the connector area is dirty, do steps 18-20 until it is clean.
22. Install the pH sensor or the dummy pH sensor on the HydroCAT-EP:

• If the HydroCAT-EP will be deployed, do the steps in Prepare pH sensor for
deployment on page 13 to install the pH sensor. Do the steps in pH calibration
on page 26 to calibrate the pH sensor.

• If the HydroCAT-EP will be stored, install the dummy pH sensor.

1. Apply a light coat of silicone-based Parker Super O Lube to the installed O-
rings on the dummy pH sensor.

2. Carefully push the dummy pH sensor onto the HydroCAT-EP.
3. Use a 3/32 inch hex wrench to carefully tighten the two captured head screws

on the top of the dummy pH sensor into the HydroCAT-EP. Do not over-
tighten.

8.3.2 Replace reference junction
The manufacturer recommends that the reference junction in the pH sensor be replaced
every 3–4 months, or if data is unstable, slow, has "drift" or the pH sensor does not pass
the calibration check. Use the manufacturer-supplied pH reference junction kit to replace
the reference junction.

Maintenance

39



8.4 Maintain pump
Sediment in the pump can cause data from the sensor to be of poor quality. To clean and
maintain the pump, put the sensor in clean water and operate the pump for 15 minutes.

8.5 Maintain optical sensor
Clean the face of the optical sensor and the optional check cap at regular intervals and
before calibration.

8.5.1 Clean optical face
1. After each deployment: flush the optical face with fresh water.

• If the optical face has visible contamination, use a small quantity of dish soap in
warm water to carefully clean the face, then flush with fresh water.

2. Clean the optical face with a lint-free, isopropyl alcohol-dampened cloth or tissue.
3. Clean the sensor within approximately 5 mm from the copper faceplate.

8.5.2 Replace wiper on optical face

C A U T I O N
 

Do not move the wiper by hand. It can damage the motor.
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Examine the wiper at regular intervals and replace the rubber wiper blade when it no
longer touches the optical face evenly, or if it is damaged.

1. Use a 3/32" hex key to loosen the 3/8" socket head cap screw in the wiper assembly
on the motor shaft.

2. Lift the wiper assembly straight off of the motor shaft.
3. Pull one end of the wiper blade to lift it out of the slot.

4. Put a small amount of isopropyl alcohol, dish soap, or water on the new wiper blade.
5. Push the larger "T"-shaped edge through the slot at an angle. It helps to compress

the wiper blade in one direction side-to-side so that it slides fully into the slot more
easily.

6. Push the wiper blade fully into the slot.

7. Carefully slide the wiper assembly back onto the motor shaft. Adjust the height so
that the wiper blade contacts the copper faceplate but does not bend. Orientation
does not matter.

8. Carefully hand-tighten the screw in the wiper assembly on the motor shaft.
When power is supplied to the sensor, the wiper will align to the closer of two points
on the copper faceplate.
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8.5.3 Clean optical sensor check cap
The check cap is optional equipment to check the calibration of the optical sensor.

1. Examine the check cap for dust, water spots, or other contamination.
It must be clean, dry, and shiny.

Clean check cap Dirty check cap

2. Soak a cotton swab with isopropyl alcohol.
3. Gently clean the glass to loosen or dissolve contamination.

4. While the glass is still wet, flush immediately with DI water to prevent a hazy film.
5. Dry the glass with a lint-free tissue (Kimwipe™ or equivalent).
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6. Blow the filter glass fully dry with Dust-Off® or dry nitrogen.
7. Replace the protective caps on each end if the check cap will not be used

immediately to check the calibration.

8.6 Clean pressure sensor

N O T I C E
 

Do not put a brush or any object in the pressure port. It may damage or break the pressure
sensor.

The nylon pressure capillary fitting has a pressure port fitting and an external capillary
tube that is filled with silicone oil. The oil transmits hydrostatic pressure from the capillary
tubing to the pressure sensor. The oil also prevents corrosion if the sensor is exposed to
water.
Because of temperature and pressure changes over long time periods, some oil will
slowly leak out of the external capillary tube. Use P/N 50025, Pressure Sensor Oil Refill
Kit to refill the oil in the tube if no oil can be seen in the tube.
At regular intervals, or annually, inspect and clean the pressure port of sensors that are
so equipped.

1. Use a flathead screwdriver to remove the pressure port plug.

2. Flush the pressure port with warm DI water to remove any contamination.
3. Replace the pressure port plug. Do not over-tighten the nylon screw.

8.7 Clean bulkhead connectors

N O T I C E
 

Do not use WD-40® or petroleum-based lubricants on bulkhead connectors. It will cause damage
to the rubber.
Damaged connectors can cause a loss of data and additional costs for service.
Damaged connectors can cause damage to the sensor and make it unserviceable.

Examine, clean, and lubricate bulkhead connectors at regular intervals. Connectors that
are not lubricated increase the damage to the rubber that seals the connector contacts.
The incorrect lubricant will cause the failure of the bulkhead connector.
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1. Apply isopropyl alcohol (IPA) as a spray or with a nylon brush or lint-free swab or
wipes to clean the contacts.

2. Flush with additional IPA.
3. Shake the socket ends and wipe the pins of the connectors to remove the IPA.
4. Blow air into the sockets and on the pins to make sure they are dry.
5. Use a flashlight and a magnifying glass to look for:

Any corrosion.

Cracks, scratches, or other damage on the
rubber pins or in the sockets.

Separation of the rubber from the pins.

Swelled or bulging rubber pins.

6. Use a silicone-based lubricant on each of the contacts of the bulkhead connector.
The manufacturer recommends any of the products listed below.

• 3M™ Spray Silicone Lubricant (3M ID# 62-4678-4930-3). Make sure to let it dry.
• Dow Corning Molykote® III Compound (DC III)
• Dow Corning High Vacuum Grease® (DC 976 V)
• Dow Corning 4 Electrical Insulating Compound® (DC 4)
• Dow Corning Molykote 44 High Temperature Grease® (DC 44)

Use a finger to put a small quantity (approximately 1 cm in diameter) of silicone
grease on the socket end of the connector and push as much of the lubricant as
possible into each socket. Do not use too much lubricant, as that will prevent a good
seal.
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7. Connect the connectors.
8. Use a lint-free wipe to clean any unwanted lubricant from the sides of the connectors.

8.8 CTD storage
When the plumbing is clean, the sensor can be prepared for storage:

• Make sure the anti-fouling devices are not installed.
• Make sure there is a dummy plug and lock collar attached to the bulkhead connector.

For short-term storage up to a week, make sure to put the manufacturer-supplied colored
plugs on the intake and exhaust plumbing ports.
For long term storage:

• Attach one end of a Tygon hose section to the exhaust port, and the other end to the
intake port to isolate the conductivity cell plumbing.

• Attach the yellow protective label over the intake and exhaust ports.

8.9 Flush sensor with DI water
1. Remove the pH sensor (HydroCAT-EP only) and store it in the white plastic holder

with KCl solution or de-ionized (DI) water if non-ionic surfactant or bleach is
necessary to clean the flow path. The pH sensor can stay installed on the sensor if DI
water is used. Do not expose the pH sensor to air for longer than a few minutes.
Refer to Prepare pH sensor for storage or shipment on page 36 for details to remove
the pH sensor.

2. Remove the copper assembly and anti-fouling devices from the sensor. Refer to 
Remove or replace anti-fouling devices on page 33 for details.

3. Use a 3/16-inch hex wrench to remove the flushing port plug, a ¼-20 x 1 inch socket
head screw.
Keep the plug to install again.

4. Put the instrument in a container with the bulkhead connector face-up.
5. Attach a 60 ml syringe to a 10 cm length of ¼ inch outside diameter (OD) tubing.
6. Attach the syringe and associated tubing to either the intake or exhaust port of the

sensor's flow path.
7. If a cleaning solution is necessary, pull approximately 30 ml of DI water into the

syringe.
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8. Pull approximately 30 ml of cleaning solution into the syringe.

9. Push the syringe plunger to fill the sensor flow path until 3–5 cm of solution shows in
each tube.

10. Push and pull the syringe plunger until there are no bubbles in the tubing.

Note that in the photo above, the syringe is attached to the exhaust port and the
waste tubing is attached to the intake port.

11. Remove the tubing and shake the sensor.
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12. Install the flushing port plug again.
The sensor is ready for a functional test in the laboratory or a deployment.
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Section 9 Software reference

9.1 Sensor dashboards
The Dashboard is the main area from which to control and communicate with the sensor.
Information about the status of the sensor is contained in the upper part of the window
and is updated each time the sensor is connected to the software.
Common settings

• Connect-Disconnect lets the user disconnect the sensor after it is set up for
operation.

• Start-Stop lets the user start and stop data collection.
• Sensor Settings lets the user select options for a specific deployment.
• Deployment Wizard lets the user select a deployment mode, start time, the

parameters to measure, estimate the deployment time and data collection interval,
and make a summary report of the status of the sensor.

• Transmit Data lets the user move data saved on the sensor to a PC.
• Show Saved Data lets the user see data that was saved on a PC in a graph.
• Command Terminal lets the user send terminal program-level commands to the

sensor.

9.2 UCI menu
The user can set up the way that the software saves information about the operation of
the sensor and change the way that the data looks from the Preferences menu.

9.2.1 General tab
Enter or change the directory on the PC in which data from the sensor is stored.

• "Maximum Wakeup Attempts" lets the user select the number of times the software
will try to connect to a sensor. Range: 5–15.

• "Response Timeout" is the interval of time between communication between the
sensor and the software. Range: 5–10.

• "Default Data Directory" lets the user enter the location on the PC in which to save
data from the sensor. If there is a check in the "Prompt at startup" box, the user can
change the directory in which the data is stored every time the software starts.

9.2.2 Display tab
Note: The software operates faster if the user selects less data and only one or two graphs.

Data that is collected by the sensor shows in the user-selected graphs in the
Performance Optimization Settings area of the Display tab.
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• RS232 only: "Enable Real Time Display"—Put a check in this box to see the data as
it is collected in either the software, or if deployed, a terminal program.

• "Enable Time Series Graph"—Put a check in this box to see user-selected data.
Remove the check in the box to so that the graph is disabled and the data does not
show.

• SUNA only: "Enable Spectra Graph"—Put a check in this box to see both dark and
light data in raw counts.

• SUNA only: "Enable Total Absorbance Graph"—Put a check in this box to see the
calculated absorbance.

Time Series Settings—The default is a check in the box for continuous data collection
that is not limited to a specified amount of time. Remove the check in the box to enable
the "Time Axis Range Limit" of 60 minutes (default value). Only the most recent hour of
data will show in the Time Series Graph. The user-selectable range is 1–1440 minutes.

9.2.3 Message tab
The software automatically saves files that have information about sensor use, data
collection, and software operation over time. This information helps the user and
Customer Support find problems and troubleshoot.
When the "Display Dialog for Error Level Messages" box has a check in it, the software
saves one of five levels of error messages.

• INFO—The default level. All high-level operations are saved.
• ERROR—Minimum level. Only errors that need to be examined by the user or

Customer Support are saved.
• WARN—Low level. The files that are saved do not have enough information for the

user to make an analysis of how the sensor is used and set up.
• DEBUG—High level. Used to troubleshoot. DEBUG and TRACE files are very large.
• TRACE—The highest level. Used only to troubleshoot.

"Daily Files"—all messages from a single day are saved in one file.
"Rolling Files"—all messages are saved in one file until it is the maximum size specified
by the user. The messages are then saved to a new file. The user specifies the number of
files to keep. The oldest files are erased first.
"Save Lost Bytes"—if this box has a check in it, the software saves all of the unexpected
output from the sensor to a file.
"File Location"—the operating system of the PC determines where these files are saved.

9.3 Sensor menu
The Sensor menus have options for each sensor with which the software communicates.
Refer to the sections on Sensor dashboards on page 49 for more information about these
items.
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Advanced Sensor menu items
Common

• Erase Data lets the user erase all of the data stored in the sensor.
• Summary Report lets the user get a summary of the settings stored in the sensor.
• Set Clock lets the user synchronize the time between the PC and the sensor.
• Collect Diagnostics is helpful for troubleshooting.

9.3.1 HydroCAT-EP
• Pair Optics Cal Cap (HydroCAT-EP) lets the user enter the serial number of a new

check cap to connect, or "pair" it with the sensor.
• Upgrade Firmware (HydroCAT-EP) lets the user install the latest firmware from the

manufacturer.

9.4 Data menu
The Data menu has sensor-specific options to look at data that has been saved to a PC.

9.4.1 Export data to .csv or MS Excel format
Data from the sensor can be saved to either a comma-separated (.csv) file or a
Microsoft® Excel file with a local or UTC time stamp. Use the software to transmit data
from the sensor and then export that data to a human-readable format.

1. From the Data menu, select Export Stored Data.
2. Push Browse to find the file to export.
3. Select the file from the list.
4. Push Open.
5. Push Next. The current output format shows (all sensors but SUNA).
6. Push Next. Select the options for the file to export:

a. Select either "Excel Workbook" or "Comma Separated Values" in Export File
Format.

b. Select the filters to apply to the data in Export Samples QAQC Filter (ECO
V2 only.)

c. Select either the "UTC" or "Local" time stamp in Format Options.
7. Push Browse to select the directory in which the exported data will be saved.
8. Push Finish.

9.4.2 Show data from multiple sensors
The software lets the user show data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to look at.

1. Go to the Data menu, then Show Data from Sensor.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors to Show.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.

9.4.3 Show data from the sensor
1. Go to the Data menu and select the applicable sensor.
2. Push Show Data from Sensor.
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3. Select the data file to look at.
4. Push Open. The data shows in the Time Series graph.

9.5 View menu
Dashboards—Go to the View menu and Dashboards to select the dashboard for a
specific sensor.
Graphs

• Time Series Graphs—all supported sensors.
• SUNA—Spectra, Absorbance, or Reprocessed Nitrate.
• SeaFET—Processed pH graph.

• SUNA Spectra graph: the user can push Configure to change the number of graphs
to view. The "Graph History Limit" range is 1–2147483647. Put a check in the "Graph
History Unbounded" box to see the total number of graphs. Default value: no check in
the box and a "Graph History Limit" of 1.

• SUNA Absorbance graph: the user can change the "Min. Wavelength Cutoff" to
between 150–400 nm to change the scale of the graph. The user can push
Configure to change the number of graphs to view. The "Graph History Limit" range
is 1–2147483647. Put a check in the "Graph History Unbounded" box to see the total
number of graphs. Default value: no check in the box and a "Graph History Limit" of
1.

• SUNA Reprocessed Nitrate graph: the user may find that it helps to reprocess data
under some conditions.

Output—Go to the View menu and select Output, then any of the three options:

• Instrument Console: the current settings in the sensor
• Processing Console: the data collected by the sensor in a comma-delimited format
• Application Console: the commands sent to the sensor from the software.

Real Time Data—Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Collection—Go to the View menu and select Data Collection to select the location
on the PC in which the collected data is saved.
Acquisition Monitor—Used by the manufacturer for troubleshooting.
Message File—Used by the manufacturer for troubleshooting.

9.6 Window and Help menus
The user can change how the software shows different windows and tabs.

• Close Current Window—closes the selected tab (highlighted in blue).
• Close all Windows—closes all tabs except the UCI Dashboard.
• Configure Window—

Maximize: increases the size of the selected tab to fill the software screen size.
Float: unlocks the selected tab from the software screen so that the user can move it
to other locations on the PC screen.
Float Groups: the same as Float above, but all tabs that are open are unlocked so
that the user can move them to other locations on the PC screen.
Minimize: minimizes the selected tab and moves it to the side of the software screen.
Minimize Group: minimizes the open tabs in the "Console," "Dashboard," or "Graph"
areas of the software.
Dock: locks the tab that the user selected to "float" back to its previous position in the
software window.
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Dock Group: the same as Dock above, but all tabs that are open are locked back into
their previous position in the software window.

Go to the Help menu to see the .pdf version of the user manuals for supported sensors
and this software reference. Go to Sea-Bird.com to go to the manufacturer's web site.

Software reference

53



Software reference

54



Section 10 Quick reference for terminal commands

10.1 Summary of terminal commands
This is a reference for advanced users. The values of these commands are stored in the
sensor until the user changes them. Notes about terminal commands are listed below.

• Commands are not case-sensitive. Use "Enter" to store a command.
• The sensor sends an error message if a command is invalid.
• The argument Y and 1 are both "Yes" and N and 0 are both "No." For example,

OutputSal=y and OutputSal=1 are equivalent.
• If there is no communication with the sensor for 2 minutes, it goes into a low power

mode. Use "Enter" to start communication again.
• Use the "Esc" key or type ^C, then "Enter" to stop the sensor as it sends data.
• If the user sent StartNow (autonomous mode) and the sensor is in operation or in

standby, the user can use the Status commands, TS, TPS, SL, QS, and Stop. For
example, if the user sends a DS to see status data, the sensor completes the current
measurement and then responds to the command. If OutputExecuted=Y, the sensor
will send "executing" messages until the measurement is complete.

• If the user sent StartLater (autonomous mode) and the sensor is operation or in
standby, the user can use the Status commands, TS, TPS, SL, QS, and Stop. To
send other commands, enter the Stop command, then enter any other commands,
and send StartLater again.

Status

GetCD show configuration

GetSD show status

GetCC show calibration coefficients

GetEC show event counter

Reset EC reset event counter

GetHD show hardware

Help shows list of available commands

DS show status and configuration

DC show calibration coefficients

pHCalHist show pH sensor calibration history related to stored data

General setup

DateTime=x set clock. format is mmddyyyhhmmss

BaudRate=x RS232 rates. Default is 19200. 600*, 1200*, 2400*, 4800, 9600, 19200, 38400, 57600, 115200.
*available only if no oxygen sensor is not installed.

ReferencePressure
=x

reference pressure, gauge, dbar for conductivity, specific conductivity, oxygen, salinity, sound velocity
calculations if a pressure sensor is installed.

*default reset most user-input settings to manufacturer's default.

ReSync update sensor with latest information from DO, fluorometer-turbidity, and pH sensors.

QS puts sensor in low power ("quiescent") state. Sensor continues to take measurements and store data.

RS232 setup

OutputExecutedTag=x Y: show executing and executed XML tags. N: do not

TXRealTime=x Y: send data in real-time. N: do not
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Pump setup

MinCondFreq=x Minimum Conductivity Frequency for pump to operate, Hz

PreFlush=x time, seconds, for pump to operate before the first measurement. Default is 300. Range 300–600.
If autonomous operation starts with StartNow, the pre-flush starts immediately.
If autonomous operation starts with StartLater, the pre-flush starts x seconds before scheduled start
time.

PreFlushStartTIme
=x

set mmddyyyyhhmmss for controlled ("polled") data collection.
set 0 to disable the pre-flush for controlled data collection.

OxNTau=x pump operation time multiplier. Default is 7.0. Range 0–100.0.

PumpTime=x time the pump operates for each measurement, when oxygen sensor is installed. Range 0–550.

PumpOn start pump. Pump will stop after 2 minutes without communication or when PumpOff is sent.

PumpOff stop pump, if started with PumpOn.

DO sensor setup (HydroCAT-EP)

Send63:command sensor sends command to DO sensor and gets response.

other commands refer to the SBE 63 manual for command list. Required commands:
SetEcho=1, SetFormat=1, SetAvg=2 (range 1–16), SetAutoRun=0.

Fluorometer-turbidity sensor setup (HydroCAT-EP)

GetOpticsRef get stored check cap reference values from the last calibration.

SetOpticsRef set check cap reference values. Sensor sends 6 measurement values, fluorescence then turbidity, at
gain settings of 1, 5, and 25, plus calibration date and serial number of check cap.

Memory setup

InitLogging make all of the memory available and erase pH calibration history. Command must be sent twice.

RecoverSamples put the pointer at the last measurement in memory and restore pH sensor calibration history.
Command must be sent twice.

Output format setup
Commands for parameters apply only if the user selects OutputFormat=1, 2, or 3. Output format commands are ignored if x=0.
Where x=N, that parameter is not part of the output.

OutputFormat=x x=0: raw decimal data
x=1: converted decimal data
x=2: converted decimal data in XML
x=3: converted decimal data in SDI-12 format

OutputTemp=x x=Y: output temperature
x=N: do not

SetTempUnits=x x=0: temperature, °C

OutputCond=x x=Y: output conductivity
x=N: do not

SetCondUnits=x x=0: conductivity and specific conductivity, S/m
x=1: conductivity and specific conductivity, mS/cm
x=2: conductivity and specific conductivity, µS/cm

OutputPress=x x=Y: output pressure, if so equipped
x=N: do not

SetPressUnits=x x=0: pressure, decibars
x=1: pressure, psi (gauge)
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OutputOx=x x=Y: output oxygen, if so equipped
x=N: do not

SetOxUnits=x x=0: oxygen, ml/L
x=1: oxygen, mg/L

OutputpH=x x=Y: output pH
x=N: do not

OutputFl=x x=Y: output fluorescence, µg/L
x=N: do not

OutputTbd=x x=Y: output turbidity, NTU
x=N: do not

OutputSal=x x=Y: output calculated salinity, psu
x=N: do not

OutputSV=x x=Y: output calculated sound velocity, m/sec
x=N: do not

OutputSC=x x=Y: output calculated specific conductivity
x=N: do not

UseSCDefault=x only applies if OutputSC =Y
x=0: do not use default. Use SetSCA=(see SetSCA below)
x=1: use default of 0.20 to calculate thermal coefficient of conductivity for natural salt ion solutions.

SetSCA=x only applies if OutputSC=Y and UseSCDefault=0 
x= calculated thermal coefficient of conductivity for natural salt ion solutions

OutputOxSat=x x=Y: outputcalculated oxygen saturation, %
x=N: do not

TxSampleNum=x X=Y: output sample number with real-time data or
sample number under controlled ("polled") data stored to memory.
x=N: do not

Autonomous data collection

SampleInterval=x x=time interval between sample measurements. Range 10–21600.
The user must set SampleInterval to the pump operation time + 38 seconds when the fluorometer-
turbidity sensor is installed. If this sensor is not installed, SampleInterval can be the pump operation
time + 8 seconds.

StartNow start sensor

StartDateTime mmddyyyyhhmmss for delayed start

StartLater start sensor at a delayed start time

Stop stop sensor or delayed start time. Sensor must be stopped before data is transmitted.

Logger-controlled "polled" data collection

TS Pump does not operate. Take sample, store data in buffer, send data.

TPS Pump operates. Take sample, store data in buffer, send data.

TPSS Pump operates. Take sample, store data in buffer and in flash memory, send data.

TSN:x Pump does not operate. Take x samples (1–100), send data.

SL Send the last sample in the buffer.

TempCheck:x Pump operates continuously while sensor takes x samples and sends data. Temperature sensor is
verified. Values for pH, oxygen, oxygen saturation, fluorescence and turbidity are not valid.

CondCheck:x Pump operates continuously while sensor takes x samples and sends data. Conductivity sensor is
verified. Values for pH, oxygen, oxygen saturation, fluorescence and turbidity are not valid.
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T63 Pump does not operate. DO sensor sends oxygen data in the format set with the SetFormat= in SBE63.

TOptics Pump does not operate. Fluorescence and turbidity sensor sends 1 set of 30 measurements in the
format set with the SetFormat= in HCO.

OpticsStats Sends the average and standard deviation results of the TOptics command.

Data upload
Make sure to send a Stop command before a GetSamples command.

GetSamples:b,e Upload scan b to e in the format set with the OutputFormat= command. A maximum of 5000 samples
can be uploaded at one time.

Coefficients
Where F = floating point number. S = string with no spaces. Date = date of calibration.
Calibration coefficients are set by the manufacturer and are the same as those shown on the Calibration Certificates that come
with the sensor. Use GetCC or DC to see calibration coefficients stored in the sensor.

TCalDate=S date of temperature calibration

TA0=F temperature A0 

TA1=F temperature A1 

TA2=F temperature A2 

TA3=F temperature A3 

CCalDate=S date of conductivity calibration

CG=F conductivity G

CH=F conductivity H

CI=F conductivity I

CJ=F conductivity J

WBOTC=F conductivity wbotc

CTCor=F conductivity ctcor

CPCor=F conductivity cpcor

CZ=F zero conductivity frequency, Hz

PCalDate=S date of pressure calibration

PA0=F pressure A0 

PA1=F pressure A1 

PA2=F pressure A2 

PTCA0=F pressure ptca0 

PTCA1=F pressure ptca1 

PTCA2=F pressure ptca2 

PTCB0=F pressure ptcb0 

PTCB1=F pressure ptcb1 

PTCB2=F pressure ptcb2 

PTempA0=F pressure temperature a0 

PTempA1=F pressure temperature a1 

PTempA2=F pressure temperature a2 

POffset=F pressure offset, decibars
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OxCalDate=S oxygen calibration date

OxTau20=F oxygen Tau20—sensor response time

OxA0=F oxygen A0 coefficient

OxA1=F oxygen A1 coefficient

OxA2=F oxygen A2 coefficient

OxB0=F oxygen B0 coefficient

OxB1=F oxygen B1 coefficient

OxC0=F oxygen C0 coefficient

OxC1=F oxygen C1 coefficient

OxC2=F oxygen C2 coefficient

OxTA0=F oxygen TA0 coefficient

OxTA1=F oxygen TA1 coefficient

OxTA2=F oxygen TA2 coefficient

OxTA3=F oxygen TA3 coefficient

OxE=F oxygen E coefficient
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Section 11 Troubleshooting

Possible problem Possible solution

Cannot communicate with
sensor

• Close the software, turn the power supply to the sensor off and disconnect the
communication connector at the PC. Turn the power supply back on, connect the
communication cable to the PC and start the software. Push Connect to start
communication again. Make sure that there is a check in the "try all baud rates" box.

• Make sure that the PC-sensor cable is connected correctly.
• Verify that the battery pack is installed.

Sensor does not save collected
data

• Make sure that the memory is not full. If it is, save the data to a PC, then erase the
data stored in the sensor.

Zero conductivity check fails • Flush the sensor with DI water.
• Make sure to remove ALL water from the flow path and the conductivity cell.
• HydroCAT: Make sure that the value on the conductivity certificate is entered correctly

in the software.
• HydroCAT-EP: make sure that the value on the conductivity certificate is the same as

the value stored in the sensor: enter "GetCC" in the terminal command area of the
software. Look for the "<Z>" value.

Optics calibration check fails • Make sure that the calibration check cap is installed correctly. The cap should be
straight, with the pin on the cap in the notch on the sensor.

• Clean the optical face.
• Make sure that the calibration cap is clean. Examine the orange glass for dust, water

spots, or other contamination. Clean if necessary.

pH calibration fails • Make sure that the standard solutions are not expired.
• Make sure that the standard solutions, the DI water and the sensor are at the same

temperature.
• Make sure that the probe is moist. If it is dry, fill the soaker cap with pH 4 standard

and soak the probe for 24 hours.
• If the pH output values are A) unstable, slow, or "drift," or B) the sensor cannot be

calibrated, refer to the section about pH sensor maintenance for details about how to
replace the electrolytes and Teflon™ junction.

Data is unreasonable • Verify that the calibration coefficients are correct.
• Make sure that the pump operates correctly.

Salinity data is out-of-spec • Clean the sensor.
• At shallow depths, air bubbles can cause the conductivity cell measurements to be

incorrect.

Wiper does not operate correctly • Examine and adjust the height of the blade to the optics face. It should just touch the
optical face.
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Section 12 General information

Revised editions of this user manual are on the manufacturer's website.

12.1 Warranty
Refer to the manufacturer's website for warranty information (seabird.com/warranty).

12.2 Lithium battery shipment

W A R N I N G
 

Do not ship the sensor with the batteries installed. Do not ship the battery pack for the sensor with
the batteries installed.

The information below is general, for guidance only to appropriately trained shipping
personnel. Refer to the IATA Dangerous Goods Regulations for complete information
about shipping lithium batteries.
The manufacturer ships the lithium cells with the sensor in a separate box. Each of the
12 cells is packed in heat-sealed plastic. All batteries are packed in bubble wrap in a
sturdy box.

Batteries that are shipped without the sensor are Dangerous Goods. They can only be
shipped by personnel with the appropriate training from an organization that has a
Dangerous Goods program.

Sensor, no spares Sensor, 1 or 2 spare cell sets Cells only

UN # 3091 3090 

PI # 969 968 

Passenger aircraft yes no

Cargo aircraft yes
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Label requirements

--

12.3 AF24173 anti-foulant device
AF24173 Anti-Foulant Devices supplied for user replacement are supplied in polyethylene
bags displaying the following label:

General information
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AF24173 ANTI-FOULANT DEVICE
FOR USE ONLY WITH SEA-BIRD ELECTRONICS' CONDUCTIVITY SENSORS TO
CONTROL THE GROWTH OF AQUATIC ORGANISMS WITHIN ELECTRONIC
CONDUCTIVITY SENSORS.
ACTIVE INGREDIENT: Bis(tributyltin) oxide . . . . . 52.1%
OTHER INGREDIENTS: . . . . . . . . . . . . . . . . . . . . 47.9%
TOTAL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100.0%
DANGER
See Precautionary Statements for additional information.

FIRST AID

If in eyes • Hold the eye open and rinse slowly and gently with water for 15–20 minutes.
• Remove contact lenses, if present, after the first 5 minutes, then continue rinsing eye.
• Call a poison control center or doctor for treatment advice.

If on skin or clothing • Take off contaminated clothing.
• Rinse skin immediately with plenty of water for 15–20 minutes.
• Call a poison control center or doctor for treatment advice.

If swallowed • Call poison control center or doctor immediately for treatment advice.
• Have person drink several glasses of water.
• Do not induce vomiting.
• Do not give anything by mouth to an unconscious person.

HOT LINE NUMBER

Note to Physician Probable mucosal damage may contraindicate the use of gastric lavage.

Have the product container or label with you when calling a poison control center or doctor, or going for treatment. For further
information, call National Pesticide Telecommunications Network (NPTN) at 1-800-858-7378.

Net contents: Two anti-foulant devices
Sea-Bird Electronics, Inc.
13431 NE 20th St.
Bellevue, WA 98005 
EPA Registration No. 74489-1 
EPA Establishment No. 74489-WA-1 

PRECAUTIONARY STATEMENTS
HAZARD TO HUMANS AND DOMESTIC ANIMALS
Danger:
Corrosive—Causes irreversible eye damage and skin burns. May be fatal if swallowed or
absorbed through the skin. Do not get in eyes, on skin, or on clothing. Wash thoroughly
with soap and water after handling and before eating, drinking, chewing gum, using
tobacco, or using the toilet. Remove and wash contaminated clothing before reuse.
PERSONAL PROTECTIVE EQUIPMENT
Users must wear: protective gloves (rubber or latex), goggles or other eye protection,
long-sleeved shirt, long pants, and shoes plus socks.

General information
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USER SAFETY RECOMMENDATIONS
Users should:

• Remove clothing immediately if pesticide gets inside. Then wash thoroughly and put on clean clothing.
• Follow the manufacturer's instructions for cleaning and maintaining PPE. If no such instructions for washables, use

detergent and hot water. Keep and wash PPE separately from other laundry.

ENVIRONMENTAL HAZARDS
Do not discharge effluent containing this product into lakes, streams, ponds, estuaries,
oceans, or other waters unless in accordance with the requirements of a National
Pollutant Discharge Elimination System (NPDES) permit and the permitting authority has
been notified in writing prior to discharge. Do not discharge effluent containing this
product to sewer systems without previously notifying the local sewage treatment plant
authority. For guidance contact your State Water Board or Regional Office of EPA. This
material is toxic to fish. Do not contaminate water when cleaning equipment or disposing
of equipment washwaters.
PHYSICAL OR CHEMICAL HAZARDS
Do not use or store near heat or open flame. Avoid contact with acids and oxidizers.
DIRECTIONS FOR USE
It is a violation of Federal Law to use this product in a manner inconsistent with its
labeling.
For use only in Sea-Bird Electronics' conductivity sensors. Read installation instructions in
the applicable Conductivity Instrument Manual.
Intended for professional use by military, government, academic, commercial, and
scientific personnel.

STORAGE AND DISPOSAL
PESTICIDE STORAGE: Store in original container in a cool, dry place. Prevent exposure to heat or flame. Do not store near
acids or oxidizers. Keep container tightly closed.
PESTICIDE SPILL PROCEDURE: In case of a spill, absorb spills with absorbent material. Put saturated absorbent material
into a labeled container for treatment or disposal.
PESTICIDE DISPOSAL: Pesticide that cannot be used according to label instructions must be disposed of according to
Federal or approved State procedures under Subtitle C of the Resource Conservation and Recovery Act.
CONTAINER HANDLING: Nonrefillable container. Do not reuse this container for any other purpose. Offer for recycling, if
available.

12.4 Waste electrical and electronic equipment
Electrical equipment that is marked with this symbol may not be disposed of in European public
disposal systems. In conformity with EU Directive 2002/96/EC, European electrical equipment
users must return old or end-of-life equipment to the manufacturer for disposal at no charge to
the user. To recycle, please contact the manufacturer for instructions on how to return end-of-
life equipment, manufacturer-supplied electrical accessories, and auxiliary items for proper
disposal.

General information
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Sea-Bird Electronics
13431 NE 20th Street
Bellevue WA 98005 U.S.A.
(425) 643-9866

© Sea-Bird Electronics, Inc., 2021. All rights reserved. Printed in USA. 
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